LENESAS APPLICATION NOTE

RX110, RX111, RX113, RX130, RX230, ROLANSZ33E00103
RX231, RX23T, RX24T Group Apr 15, 2016

RX Driver Package Ver.1.03

Introduction

This document is the RX110, RX111, RX113, RX130, RX230, RX231, RX23T, RX24T Group RX Driver Package
User’s Manual, version 1.03.

This User’s Manual describes basic structures, features and usage of RX Driver Package applications, and about the
sample application program using the FIT modules included in this package.

Target Device

RX110 Group (Renesas Starter Kit for RX110)
RX111 Group (Renesas Starter Kit for RX111)
RX113 Group (Renesas Starter Kit for RX113)
RX130 Group (Renesas Starter Kit for RX130)
RX230 Group (Renesas Starter Kit for RX230)
RX231 Group (Renesas Starter Kit for RX231)
RX23T Group (Renesas Starter Kit for RX23T)
RX24T Group (Renesas Starter Kit for RX24T)

When using this application note with your product, careful evaluation is recommended.

And when using this application note with other Renesas MCUSs, careful evaluation is recommended after making
modifications to comply with the alternate MCU.

Related Documents

e RX Family Board Support Package Module Using Firmware Integration Technology (ROLAN1685EU)
¢ Firmware Integration Technology User’s Manual (RO1AN1833EU)

e RX Family Adding Firmware Integration Technology Modules to Projects (RO1IAN1723EU)

o RX Family Adding Firmware Integration Technology Modules to CS+ Projects (ROLAN1826EJ)

e The User’s Manual provided with the RX Driver Package Application.
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1. Overview

1.1 Applicability

This User’s Manual applies to the RX110, RX111, RX113, RX130, RX230, RX231, RX23T, RX24T Group RX Driver

Package, version 1.02.

1.2 Operating Environment
This package runs under the operating environment described below.

Table 1-1 Operating Environment (RX110)

Microcontroller

RX110 Group

Evaluation board

Renesas Starter Kit for RX110

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-2 Operating Environment (RX111)

Microcontroller

RX111 Group

Evaluation board

Renesas Starter Kit for RX111

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-3 Operating Environment (RX113)

Microcontroller

RX113 Group

Evaluation board

Renesas Starter Kit for RX113

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-4 Operating Environment (RX130)

Microcontroller

RX130 Group

Evaluation board

Renesas Starter Kit for RX130

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20
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Table 1-5 Operating Environment (RX230)

Microcontroller

RX230 Group

Evaluation board

Renesas Starter Kit for RX230

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-6 Operating Environment (RX231)

Microcontroller

RX231 Group

Evaluation board

Renesas Starter Kit for RX231

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-7 Operating Environment (RX23T)

Microcontroller

RX23T Group

Evaluation board

Renesas Starter Kit for RX23T

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20

Table 1-8 Operating Environment (RX24T)

Microcontroller

RX24T Group

Evaluation board

Renesas Starter Kit for RX24T

Integrated development
environment (IDE)

e? studio, V4.0.2 or later

Cross tools

RX Family C/C++ Compiler Package V2.03.00 or later

Emulator

El, E20
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2. About RX Driver Package

The RX Driver Package is a software platform (framework) that combines the following modules to be required for
development in a single package. Since the package contains multiple modules, you can start developing immediately
without having to obtain each module separately.

Board Support Package (BSP) module

FIT peripheral function modules (free version)

FIT middleware modules (free version)

FIT interface modules

You can develop the user application layer with ease by using the Sample Application Program (RX Driver Package
Application) which utilizes the RX Driver Package.

2.1

System Structure

The figure below shows the system structure of the RX Driver Package.

RX Driver Package Application

[

e2 studio
project
- ' *
RX Driver POSIX Wrapper ]
FIT Modul
Package (F0 e
- l ~ l A 4 A 4 .
Middleware Middleware Bevies BrivEr e2 studio
L (FIT Module) L (FIT Module) (FIT Module)
P ! 1 ]
Device Driver Device Driver Device Driver Device Driver CC-RX
(FIT Module) (FIT Module) (FIT Module) (FIT Module) -

(rerace ) (Shaione) b2 L_scc
merace e RTOS Wrapper * |"-'-'-'-'-'-'-‘
Dovice ][ ] (FIT Module) L__IAR |

X s (| 1 11 pe—  Jl 11| +-------
Driver |
{ RTOS i
Standard 3! i
] __(UITRON, FreeRTOS, etc) | Support
P K . ‘I'3 dsS rt P. : 4 S e
' oard Support Package
1
. [ (BSP Module) ] )
""""" | |
PP— C — ) 3 i .
i - -
| Third party evaluation i Renesas Starter Kit E1l, E20
. b_ o_ard H )

Figure 2-1 System Structure
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2.2 RX Driver Package Features
The RX Driver Package has the following features.

(a) Select necessary modules and start developing immediately the application program
You can easily build a system simply by selecting the modules you need from the package. After that, all you have to
do is develop the application program.

User System
(Server System)

Figure 2-2 An example of system build

(b) Free to use
All the modules included in the RX Driver Package can be used free of charge. Free versions of middleware modules
such as TCP/IP and file system are included.

(c) Can upgrade to paid versions of modules

The free versions of modules in the RX Driver Package can be replaced with commercial (paid) versions. By using a
commercial (paid) version, all the functionality of the module will be available, as well as support about a commercial
version.

(d) Check operation including user application

The RX Driver Package Application is provided as a sample user application that uses the RX Driver Package. The RX
Driver Package Application consists of programs for operating each module in the RX Driver Package, and the project
files for building the programs. It enables you to start checking the operation of your user application immediately.

RO1AN3233EJ0103 Rev.1.03 Page 6 of 28
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3. Structure of the RX110, RX111, RX113, RX130, RX230, RX231, RX23T, RX24T
Group RX Driver Package

3.1 Folder Structure
The folder structure used in this package is shown below.

When the ZIP file for this package is downloaded from the Renesas web site and decompressed, a folder of the same
name will be present and it will contain a FITModules folder, a reference_documents folder, and this document.

The FITModules folder contains the FIT modules for the modules shown in Table 3-1(as ZIP files and XML files).

The reference_documents folder contains the documentation for using this package in various development

i

RX110, RX111, RX113, RX130, RX230, RX231, RX23T, RX24T Group RX Driver Package ZIP file
(an_r01an3233ej**** rx.zip)

l

an_r01an3233ej**** rx_fit

| _POF |
FITModules reference_documents Application Note

(r01an3233ej****_rx.pdf)
l (This document)

! l | !
(W \ = =

o [ — —
FIT Module XML FIT Module ZIP file Adding Firmware Integration Adding Firmware Integration
(r_®=%_y* *% xml) (r_***_y* *% z7ip) Technology Modules to Technology Modules
Projects to C5+ Projects

(rO0lan1723***%%*% ry pdf) (r0lan1826****** rx pdf)

Figure 3-1 Folder Structure of the RX110, RX111, RX113, RX130, RX230, RX231, RX23T, RX24T
Group RX Driver Package
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3.2 Module Structure
The figure below shows the types and structure of the FIT modules included in this package.

Figure 3-2 RX110, RX111, RX113, RX130, RX230, RX231, RX23T, RX24T Group RX Driver Package
FIT Module Structure
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3.3

FIT Modules
The table below lists the FIT modules included in this package.

Table 3-1 RX110, RX111, RX113, RX130, RX230, RX231, RX23T, RX24T Group RX Driver Package FIT Modules

Type Module FIT Module Name R R R R R R R R Rev
X X X X X X X X
111122 2 2
1113 3 3 3 4
013 001TT
Board Support Board Support Package (BSP) r_bsp v v v v v v v Y330
Package
Device Driver  Voltage Detection Circuit (LVD) r_lvd_rx v v v - - Vv - - 150
Device Driver  Clock Generation Circuit (CGC) r_cgc_rx100 v v v - - - - - 131
Device Driver  Clock Frequency Accuracy r_cac_rx v v - - - - - - 110
Measurement Circuit (CAC)
Device Driver  Low Power Consumption (LPC) r_lpc_rx100 v v v - - - - - 130
Device Driver  Battery Backup (VBATT) r_vbatt_rx - - - - Vv Vv - - 101
Device Driver  Interrupt Controller (IRQ) r_irg_rx v v v v v v VY19
Device Driver  Data Transfer Controller (DTC) r_dtc_rx v v v v v v 204
Device Driver  DMA Controller (DMAC) r_dmaca_rx - - - - Vv v - - 103
Device Driver  1/O Ports (GPIO) r_gpio_rx v v v v v vV Y200
Device Driver  Multi-Function Pin Controller (MPC) r_mpc_rx v v v v v v vV 200
Device Driver  Multi-pulse Timer Unit (MTU2a) r_mtu_rx v v v - - v - - 120
Device Driver ~ Compare Match Timer (CMT) r_cmt_rx vV v v v vV VY 29
Device Driver  Real-Time Clock (RTC) r_rtc_rx v v v v v - 24
Device Driver  Low Power Timer (LPT) r_lpt_rx - - v - - - - - 100
Device Driver  Independent Watchdog Timer (IWDT) r_iwdt_rx v v v v v v v/ - 151
Device Driver  Serial Communications Interface (SCI: r_sci_rx v v v - - v v - 170
Asynchronous/Clock Synchronous)
Device Driver  Serial Communications Interface (SCI: r_sci_iic_rx v v v v v v v V190
Simple 12C Bus)
Device Driver  12C Bus Interface (RIIC) r_riic_rx v v v v v v V190
Device Driver  Serial Peripheral Interface r_rspi_rx v v v - - v - - 140
Device Driver  Serial Peripheral Interface (RSPI: Device I_rspi_smstr_rx v v v v v v v v1I10
Driver for Serial Memory Control)
Device Driver  USB Basic Firmware r_usb_basic_mini - v v - - v - - 102
Device Driver  USB Host Mass Storage Class r_usb_hmsc_mini - v v - - v - - 102
Device Driver  USB Host Communication Device Class r_usb_hcdc_mini - v v - - v - - 102
Device Driver  USB Host Human Interface Device Class r_usb_hhid_mini - v v - - v - - 102
Device Driver  USB Peripheral Mass Storage Class r_usb_pmsc_mini - v v - - Vv - - 102
Device Driver  USB Peripheral Communications Device r_usb_pcdc_mini - v Vv - - v - - 102
Class
Device Driver  USB Peripheral Human Interface Device r_usb_phid_mini - Vv v - - Vv - - 102
Class
Device Driver  IrDA Interface (IrDA) r_irda_sci_rx - - Vv - - - - - 10
Device Driver ~ CAN Module (RSCAN) r_rscan_rx - - - - - Vv - - 100
RO1AN3233EJ0103 Rev.1.03 Page 9 of 28
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Type Module FIT Module Name R R R R R R R R Rev
X X X X X X X X
11112 2 22
1113 3 3 3 4
01 3 001 TT
Device Driver  12-Bit A/D Converter (S12AD) r_sl2ad_rx v v v vy v v - 21
Device Driver  D/A Converter (DAC) r_dac_rx - vV Vv vV vV VYV V280
Device Driver  Flash Memory (Flash API) r_flash_rx v v v v - v v Vv 160
Device Driver  Serial Sound Interface (SSI) r_ssi_api_rx - - v - v v - - 120
Device Driver  LCD Controller/Driver (LCDC) r_lcdc_rx - - v - - - - - 100
Device Driver  Unique ID Read r_uid_rx v v v - - - - - 100
Device Driver  Byte Queue Buffer (Data Management) r_byteq v v v v v v v/ V160
Device Driver  Long Queue Buffer (Data Management) r_longq v v v v v v vy v 160
Middleware TCP/IP M3S-T4-Tiny for Embedding r_t4_rx v v v v v v vV 205
Interface Embedded TCP/IP M3S-T4-Tiny Socket r_socket_rx v v v vy v vy v/ VL3
API Module
Middleware DHCP client using the embedded TCP/IP r_t4_dhcp_client  x - - - - - - - - 1083
M3S-T4-Tiny Module
Middleware DNS client using the embedded TCP/IP r_t4_dns_client_rx - - - - - - - - 102
M3S-T4-Tiny Module
Middleware FTP server using the embedded TCP/IP r_t4_ftp_server_rx - - - - - - - - 103
M3S-T4-Tiny Module
Middleware Web server using the embedded TCP/IP r_t4_http_server rx - - - - - - - - 104
M3S-T4-Tiny Module
Middleware Sound playback system and compression r_s2_rx - v v - - v - - 303
system (original ADPCM codec)
Middleware M3S-TFAT-Tiny (FAT file system) r_tfat rx - v v - - v - - 302
Interface M3S-TFAT-Tiny Memory Driver Interface r_tfat_driver_rx - v v - - v - - 102
Module
Middleware Simple 12C Module for EEPROM Access r_eeprom_sci_iicrx v v v - - - - - 130
Middleware 12C Bus Interface (RIIC) Module for r_eeprom_riic_rx v v v - - - - - 140
EEPROM Access
Middleware SPI Serial EEPROM Module r_eeprom_spi v v v v v v 233
Middleware SPI Serial Flash memory Module r_flash_spi v v v v v vV VvV 233
Note: This package includes the M3S-T4-Tiny (TCP/IP protocol stack library) of evaluation version. For the

commercial version, please go to the below URL.
http://www.renesas.com/mw/t4

RO1AN3233EJ0103 Rev.1.03
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4. Usage Procedures

The RX Driver Package allows programs to be easily constructed by using the FIT plugin included in e studio. The
remainder of this section presents a simple usage example using e? studio. To use CS+, see the document “RX Family
Adding Firmware Integration Technology Modules to CS+ Projects (RO1AN1826EJ)” included in this package.

4.1 Environment Used

The RX231 is used as the target microcontroller and the Renesas Starter Kit RX231 is used as the target board. If a
different environment is used, replace the specifics used in the example with the ones for that environment as you read.

4.2 Install RX Driver Package in e? studio
Install the FIT modules in the RX Driver Package into e? studio.

1. Decompress the downloaded file an_r01an3233ej0101_rx.zip into an arbitrary directory.
2. Open the folder that was decompressed and open the FITModules folder in that folder.

3. Select all the files in the FITModules folder and click Copy in the Edit menu.
(ool
@Q'\ » » FTModules » v [ 44 ||[ Search FitModutes Fe)

fie | ga [wer—Toor—Eep

Organize ¥ Include in library Share with v New folder i - n| 9

X Favorites [T e o vl = o g ol Ol 15d i

: : - ot ey i Select all files and click
B Yty e Il Pt —— Copy in the Edit menu.
: .

B & =il 1w, o el 2 Manky m ol T1.

9 Libraries

8 Computer ol i, v Ll ol e el e el =T
€ Network 1 ore vl I g o] s = i e ] M

E8 Control Panel e m ol Iy T eyl il &
3] RecycleBin R b w2 ey el T s o, e sl T i B

FITMcdules

reference_documents

84 items
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4,

Open the e? studio install folder (Usually, this will be c:/Renesas/e2_studio.) and open the FITModules folder in

that folder.

Click Paste on the Edit menu.

The e? studio FITModules folder will be copied to the FIT modules.

=5 EoR |
@Qv' » Computer b Local Disk(C:) » Renesas » e2_studio » FITModules » v [ #3 |I[ Search FitModules o Open the FITModules
File| Edit [rem—Feot—tiep folder and click Paste
Organize ~  [3Open  Newfolder - O @ on the Edit menu.
. The folder will be copied.
L] 5 X 1
| RSy 1 = :
Renesas — z 1
- - :
. e2_studio -
DebugComp i =
Drivers
eclipse » -
etc n Ha
FITModules = =
internal - (I m 'I
86 items selected
0 Show more details

4.3 Application Creation
In this section, create a simple application that drives an LED.

43.1

First, create a new workspace and a new project.

1.

Start e? studio.

Create a Workspace and a Project

2. Enter an arbitrary workspace folder in the displayed dialog box and click OK.

Workspace Launcher @
Select a workspace
&2 studio stores your projects in a folder called a workspace,
Choose a workspace folder to use for this session,
Workspace| | Sr— Enter a workspace
folder.
[7] Use this as the default and do not ask again
ok JH—¢cemee—] Click OK.
RO1AN3233EJ0103 Rev.1.03 Page 12 of 28
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3. When the following window is displayed, click Workbench.

@ Welcome 52

— Click Workbench.

4. When the workbench has started, select New from the File menu and click C Project.

Edit Source Refactor

Mavigate Search Project Run  Window Help

Click here.

Mew Alt+Shift+N » Renesas FIT Module
Open File... | | C Project I
= Ctrl+W Geee g
Close All Ctrle Shift+ W Makefile Project with Existing Code
Y Project...
] save Ctrl+S )
B | Savehs.. Convert to a C/C++ Project (Adds C/C++ Nature)
[ Save Al CirleShiftes | B3 Source Folder
Revert % Folder
Ef Source File
RS [ Header File
[ Rename.. = [ File from Template
21 Refresh F5 & Class
Convert Line Delimiters To 3 & Task
& |[Pant.. CrleP =4 Other.. Ctrl+N
Switch Workspace 3
Restart
g2y Import...
e  Export.
Properties Alt+Enter
Exit

-
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5. Enter the project name. For the project type, click Sample Project under Executable (Renesas). For the tool chain,

click Renesas RXC Toolchain. After making these settings, click Next.

Enter the

Create Directory for Project

Project type:

I C Projec o s
C Project —
Create C project of selected type
Broject name| led_sample
Use default location
Ch\sample_workspacelled_sample Browse

Toolchains:

Executable (Renesas)
@ Sample Project

KPIT GMUARM-RZ-EABI Toolchain

project name.

Static Library (Renesas)

& Sample Project

Debug-Only Project

Executable

Executable (IAR)

Shared Library

Static Library

WB00 Standalone Executable (Green Hills)

KPIT GMURX-ELH Toolchain
KPIT GNUSH-ELH Taolchain
Renesas RKC Toolchain:
Renesas SHC Toolchain

VB0D Standalone Static Library (Green Hills)
V800 ThreadX Executable (Green Hills)
Makefile project

4 | m F

Show project types and teclchains only if ]

hey are supported on the platform

@ <gack [ Mea> |[ Finsh |[ Cancel |

Click here.

6. Select the target. Click the “...” button under Target Selection and select R5F52318AxFP. After making these

settings, click Next.

C Project

e2 studio - Project Generation

Select Target Specific Settings

o fo ]

Toolchain Version : [VZ.OI.CICI

Debug Hardware: [E‘l

Data endian : [Little-end\an data

Select Target:

Select Configurations:

HardwareDebug : Debug usi

ng hardware

Debug using Simulator @ Debug using simulator
[T Release [ne debug) : Project without any debug infermation

Build configurations will be created in the project only for the selected debug mode
options, however by default the project will be built for the active configuration i.e.,
first configuration selected from group. Based on the device selection you made
(RXB00) the debug hardware (E1) and debug target (RSF56107VxFP), debug
configuration will be automatically created for you.

@ < Back

Click here and
select
R5F52318AxFP.

Click here.

RO1AN3233EJ0103 Rev.1.03
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7. Set the check box of “Use FIT module” and click Next here.

7] C Project
e2 studio - Project Generation

Code Generator and FIT Settings

Use Peripheral code Generator

= e |

1
Use FIT module | [Down\oad FIT moddles |

Set the check box

The e2 studio peripheral code generator automatically generates programs (device drivers) for MCU peripheral functions (clocks, timers, serial
interfaces, A/D converters, DMA controllers, etc.) based on settings entered via a graphical user interface (GUI). Functions are provided as application
programming interfaces (APIs) and are not limited to initialization of peripheral functions.
Conventionally, the information "CMCU initial settings’, "How to define a target board', "File configuration’, "Names of functiens’, "Coemmeon interface
with user application” etc; has in many cases varied by sample code, so changes needed to be made to sample code when embedding into a user
application. With FIT, there are rules for this information, so each sample code can be embedded into a user application with ease. Also, the peripheral
function drivers and middleware which support FIT have a common interface with user applications. This makes it easy to port user applications when

migrating between RX microcontrollers.

[ User Application ]

CG
Device Driver

Middleware
RTOS
Device Driver (BSP)

FIT

MCU ]

< Back Next > JILL Einish ] [

Cancel L | Click here.

8. Simply click Next here.

C Project

e2 studio - Project Generation
Select Additienal CPU Options

Select Additional CPU Options:

Round: [Nearest ']
Precision of Double: [Single precision V]
Sign of Char: [Unsigned v]
Sign of bit Field: [Unsigned v]
Allocate from Lower Bit [Lower bit V]

Width of Divergence of Function: [24 Bit

Specify Global Options:

|1 Replace from int with short

[] Enum size is made the smallest

[] Pack structures, unions and classes
[7] Use try, throw and catch of C++

[] Use dynamic cast and typeid of C++

[ Denormalized number allowed as a result

@j « Back

Click here.
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9. Simply click Next here.

C Project

e2 studio - Project Generation

Global Options Settings

o [fo=s]

Patch code generation [None

Fast interrupt vector register: [None

@

s

ROM: [Nene -
RAM: [Nene -
Address (H: 00000000

Address Register: [Nene -

10. Simply click Finish here.

|e? ¢ Project

e2 studio - Project Generation

Standard Header Files

Library cenfiguration:

Select Header Files:

C(c99)

runtime : Runtime routines (Checked and disabled by default)
[Tl ctype.h : Character classification routines
[T math.h : Mathematical /trigonometric operations(double-precision)
[T mathf.h : Mathematical /trigonometric operations(single-precision)
[Tl stdarg.h : Variable argument functions
[¥] stdie.h : Input/Output
[¥] stdlib.h : General purpose library features
[¥] string.h : String handling operations
[Mlios{EC++) : Input/Output Streams
new(EC++) : Memaory allocation and deallocation routines
[C] complex(EC++) : Complex number operations
[ string(EC++) : String manipulation cperations
"] complex.h{C99) : Performs complex number calculation
[ fenv.h(c9g) : Sets floating point environment
[Clinttypes.h(C99) : Converts integer type format
[T weharh(Cgg) : Performs wide character
[TJwetype.h(C99)  : Performs wide character conversion

Select All || Deselect All

“ Finish

Click here.

Click here.
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11.Click OK. The project will be generated. .
Summary |E|

Project Summary:

———————— PROJECT GEMERATOR -------- -
PROJECT NAME : led_sample

PROJECT DIRECTORY : Ch\WorkSpace\RDP\led_sample
CPU SERIES :

CPUTYPE:

TOOLCHAIN MNAME : Renesas RXC Teolchain
TOOLCHAIN VERSION :

GEMNERATION FILES :

C\WorkSpace\RDP\led_sampletsrctled_sample.c
Main Program

4 3

Click OK te generate the project or Cancel to abort.

[ 0K 1|H Tancel ] Click here.
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4.3.2

Install the FIT Modules with the FIT Plugin.

Install the required modules with the FIT plugin into the created project.

Here, install the BSP module (r_bsp) and the compare match timer driver (r_cmt_rx).

In the Renesas Views menu, select e2 solution toolkit and click FIT Configurator.

[ C/Cer - e2studio | S

File Edit Source Refactor Navigate Search Project [RenesasViews| Run Window Help

= | ® > v o= fofiH CiCHe B E s R e R - Quick Access || % | [E@C/Cer )
Code Generator »

[ Project Explorer 52 B Y= 0 Debug = B % Outline 52 ake T =g

> |5 led_sample [HardwareDebug]

Click here.

€2 solution toolkit E;‘_g FIT Configurator

Partner 05 » |y Optimization Assistant

Renesas 05 >

An outline is not available.

@ Smart Browser
) Smart Manual

[#] Problems &2 Tasks Console operties Memory Usage [ig] Stack Analysis
0 items

Description Resource Path Location Type

L5 Ied_sample

A=)

In the FIT Configurator tab,

Select the created project with Project to Add FIT Module to.

Next, select RX231 under Group and select RSKRX231 from Target Board.
Next, click r_cmt_rx in the module list and click Add Module >>.

sasem ||
10/1/2015 |

PO ARE DS

L4 T
o 5~ (== (T )

[e7 ¢/C++ - 2 studio ==

File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

0 | @~ = 5 F O g G O = S = Quick Access | [ | [ERC/Cer )

[ Project Explorer 53 = 8 = B = Outline 52 akeTarget = B
BES® 7

> (5 led_sample [HardwareDebug] An outline is not available.

[£] Problems = Tasks [ Console [T] Properties Memory Usage [&] Stack Analysis & Smart Browser | [T FIT Configurator &%

Name of the project to add FIT modules: [|led_sample

Target Board I A Iﬁdvamed Filters...

Available Modules

%] Generate Code = = 5

o[

Select the target board.

Selected Modules

Modules Version  Description = || Modules Version
" bsp 300 Board Support Packages. &l
" byteq 150 Byte-based circulr buffer ibrary.
cmtu o 110 CMTW Driver L.
remt. 260 Simple CMT driver for creating timer tick, | Select this item.
T 750 Digital-to-Analog Converter driver
 dmaca 103 DMACA driver
e o 203 DTC driver
_eeprom_spi 232 Renesas R1EX25ix series Serial EEPROM control seftware RX Driver Package
ether o 1 Ethemet Nincer
[Add Module >> t==Remove Modute
Details

Dependency: r_bsp version(s) 280
This module crestes a timer tick using a CMT channel based on a frequency input by the user.

RO1AN3233EJ0103 Rev.1.03
Apr 15, 2016

RENESAS

Select the project.

Click here.

Page 18 of 28



RX110, RX111, RX113, RX130, RX230, RX231, RX23T, RX24T Group RX Driver Package Ver.1.03

3. Inthe Console tab,
The r_bsp having a dependency with r_cmt_rx is also added at a time. Note
Click FIT Configurator again.

Note: Additional FIT driver specifies the adaptable "r_bsp" version.
If the "r_bsp" versions specified and added mismatch according to the time of FIT driver release,
Warning (W0000001) is output on the console screen.
If the "r_bsp" version added is the one specified or later, Warning can be ignored, as the new "r_bsp" version
is backward compatible.

*! Problems J=| Tasks ) Console 52 [] Properties [ Memory Usage Stack Analysis &% Smart Browser F'T-I*!"ITCom‘igurator =k | *[f>= 8
2 ]
FIT Configurator Conscle
Meeeeeel: The following dependencies have been added for the following module: -
+ . b i =1 1
SR —S5p
wWeeeeesl: The following dependencies versicns are mismatched: C“Ck here'
r_cmt_rx: r_bsp version(s) 2.9@

This is an example of CMT driver specifying the BSP ver. 2.90.

If the r_bsp added is ver. 2.9 or later, ignore this warning
because of backward compatible.

4. Check r_bsp and r_cmt_rx are added in Selected Modules. The mark ‘2 on r_cmt_rx indicates occurrence of the
Warning explained in the above 3.
Then, click Generate Code.

® ! Problems J-| Tasks &) Console [T Properties [ Memory Usage Stack Analysis @ Smart Browser T *FIT Configurator 52 %] Generate Code ~ = O
P ry Usag e : b 9
\
Name of the project to add FIT modules: [Ied_sample \ v]
L3

TorgetBoord [Jummimmm <] Advenced Ftes. Click here.
Available Modules Selected Modules
Modules Version  Description * || Modules Version
r_bsp 3.00 Board Support Packages. 3 r_bsp 3.00
r_byteq 1.50 Byte-based circular buffer library. ) r_cmt_rx 2.60
r_emibw_rx 110 CMTW Driver
r_crt_re 260 Simple CMT driver for creating timer tick. \
r_dac_rx 2.50 Digital-to-Analog Converter driver Check here
r_dmaca_rc 1.03 DMACA, driver
r_dtc_m 203 DTC driver
r_eeprom_spi 232 Renesas R1EX2500 series Serial EEPROM control software RX Driver Package
¢ athar re 1n2 Ethernet Nrivar S
Add Module == << Remove Module
Details

Dependency: r_bsp version(s) 2.90
This medule creates a timer tick using a CMT channel based on a frequency input by the user.
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5. Click OK with changing anything.

@ FIT Generation - Summary | 3 |
Follewing modules will be installed: -
r_bsp
r_crnt_re

Follewing include paths will be added to project setting:
/% ProjMame}/r_bsp

/8{ProjName}/r_config

J&{ProjName}/r_cmt_rx

/& ProjName}/r_cmt_r/sre

Click OK to continue, Cancel to go back

Click here.

[ QK l|{ Cancel ]

RO1AN3233EJ0103 Rev.1.03 Page 20 of 28
Apr 15, 2016 RENESAS



RX110, RX111, RX113, RX130, RX230, RX231, RX23T, RX24T Group RX Driver Package Ver.1.03

4.3.3 Create an LED Driving Program
Create a program that toggles the LEDO on/off state every 0.5 seconds using the compare match timer.

Open the file src/(the project name).c and modify it as shown below.

src/(the project name).c

#include "platform.h"
#include "r cmt rx if.h"

/* LED Currently status */
uint32 t ledstatus = LED_OFF;

void call back(void *pdata)
{
if (ledstatus == LED OFF)
{
/* Turn ON the LEDO If the status is LED OFF */
LEDO = LED_ON;
ledstatus = LED_ON;
}
else

{
/* Turn OFF the LEDO If the status is LED ON */

LEDO = LED OFF;
ledstatus = LED OFF;
}
}

void main (void)

{
uint32 t cmt ch;

/* LEDO off */
LEDO =LED OFF;
/* Create of 0.5 second(2Hz) cyclic timer. */
R CMT CreatePeriodic (2, &call back, &cmt ch);

while (1) ;
}

RO1AN3233EJ0103 Rev.1.03
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434 Build and Try Running the Program
Build the program just created and verify that it runs.

1. Click Build Project on the Project menu.

2 studio
Search | Project | Run  Window Help

l : Dﬁ : Open Project

Close Project
= 8
~

Build All Ctrl+B

Build Configurations 3

=

Build Project

Click here.

Build Working Set »
Clean...

Build Automatically

Renesas Quick Settings Alt+Q
Update All Dependencies Alt+D
Make Target 3

C/C++ Index 3

Properties

e LEDE 1

oo wink3a.b omt_ch;
51

52 /* LED@ off

*

2. When the build completes, the following will be displayed in Console view.

[5. Problems 2| Tasks [ Consele 57 [ Properties Memory Usage [ig] Stack Analysis

CDT Build Console [led_sample]

C:\Renesas\E22FCB~1\DEBUGC~1\RX\RX_CON~1.EXE led_sample.abs led_sample.x

Loading input file led_sample.abs
Parsing the ELF input file.....

25 segments required LMA fixes
Converting the DWARF information....
Constructing the output ELF image....
Saving the ELF ocutput file led_sample.x

'Build complete.’
17:31:13 Build Finished (tocok 195.594ms)

4 | 1 |

3. Click Debug Build on the Run menu.

Project Window Help

% &7 |@ Run Ctrl+FLL
%, Debug F11

Run History
Run As

oot

Run Cenfigurations...

Debug History
Debug As

WLl L
LY,

status i

Debug Configurations...

——— Click here.

Teggle Breakpoint Ctrl+Shift+B

WoR =G0 s

Teggle Line Breakpoint

Teggle Method Breakpoint

5
<]

Teggle Watchpoint
s Skip All Breakpoints

Remove All Breakpoints

51 Breakpoint Types

% External Tools

status

13

L3

[Z: Problems %] Tasks | E] Conscle 32 | = Properties

Memory Us
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4. Click # under the Renesas GDB Hardware Debugging and click led_sample HardwareDebug. Click the
Debugger tab and click Connection Setting.
Modify EXTAL Frequency to be 8.0000 and change Provide Power from Emulator to No *.
When these changes have been made, click Debug.

Note : This is setting when using an external power supply. When supplying power from the emulator, select Yes.

Debug Configurations

Create, manage, and run configurations

TEX| B -

Name: led_sample HardwareDebug

)

type filter text |2 Main :’;}1 Debugger = Startup| B Source| 5] Common
[c7] Debug-only - )
-GDE Herd Debuoai Debug hacd £l x TargetDevice: Click here.
[c7 GDB Simulator Debugging (SH, RL7
kg GHS Local C/C++ Laungh GDE Settings| Connection Settings |[Debug Tool Settings
:¥ Renesas GDB Hardware fittach . Clock
Renesas GDB Hardware Pebugging Main Clock Source EXTAL g )
[c7] led_sample HardwareDebug Extal Frequency[MHz] |: L Modlfy to be
» [E9 Renesas Simulator Debugging (RX o Permit Clock Source Change On Writing Inte Ves - 8.0000.
4 Connection with Target Board
Ermulator (Auta) )
Cennection Type JTag -
ITag Clock Frequency[MHz] 16.5 -
Fine Baud Rate[Mbps] 2.00 -
Hot Plug Mo -
4 Power
Power Target From The Emulator (MAX 200n Mo M Od |fy to be NO .
Supply Voltage 3.3V -
4 CPU Operating Mode
Register Setting Single Chip -
Mede pin Single-chip mode -
4 Communication Mode
Mede Debug Mode -
Execute The User Program After Ending The [ Mo - -
4 . * [ Appl ] [ R
rt
Filter matched 9 of 13 items pply EVEl
@ [ peus [—e=— Click here.
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5. When the following message is displayed, click Yes.
Confirm Perspective Switch @

This kind of launch is configured to open the Debug perspective when it suspends,

This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint
management.

Do you want to open this perspective now?

"] Rermember my decision

+

2 | ——va— Click here.

6. When the load module download completes, a Debug perspective opens.

&7 Debug - led_sample/r_bsp/board/rsknédm/resetprg.c - €2 studio [ E ==
File Edit Source Refactor Mavigate Search Project Run  Window Help
- (B - /- N PO H-C-L- > BN I [ Ni=R 2 =40 o | 8 Quick Access || B | @crces (35 Debug
%5 Debug 52 Oy v, @& 8|26 T = O 0= Variables 13 =g
4 [£7 led_sample HardwareDebug [Renesas GDB Hardware Debugging] % | ¢ e v
4 52 led_samplex ] _ Name Type Value i
4 /% Thread [1]1 (No thread info available) (Suspended : Signal : SIGTRAP: Trace/breakpoint trap)
= PowerON_Reset_PC() at resetprg,c:122 0xffc017e8
ol gdb
s GDB server
] resetprg.c 52 = 8 8% Outline 27 = B8
once this initialization is complete, the user's main() function is called. It should not return. . PEANY o % T
Arguments none
* Return value : none U hclibh
R R # BSP_DECLARE_STACK
ffc@l7e8 ~ void PowerON_Reset_PC(void) o platform.h
{ # PSW_init =
/* Stack pointers are setup prior to calling this function - see comments above # ESWint
/* Initialize the Interrupt Table Register */ # FPSW.init
ffco17fs set_intb((void *)_ sectop("CSVECT")); ++ _INIT_I0LIB{void) : void
4 _CLOSEALL{void): veid
/* Initialize the Exception Table Register £ my_sw_warmstart_p wvoid
ffcou7ff set_extb((void *)__sectop("EXCEPTVECT")); A my_sw_warmstart_p oid
‘ i ++ PowerON_Reset_PClvoid) : void L
E Console 57 | v Tasks % Renesas Coverage Memory Usage (- Performance Analysis (% Profile 1% Real-time Chart @2 Trace ('} Visual Expression [Z Problems (3 Executables [J Memory =8
|BEEE & e-ri-
led_sample HardwareDebug [Renesas GDB Hardware Debugging] gdb
monitor set_io_access_width,Ru,1, d, d, d,902b; bd,982c6-902cd, 902d dd, d,90276-9027d, 98306-9038d, 99516 -9031d,98326-9032d, 99536 -9833d, 98346-9034d, 98 ~
monitor set access_width,RiW,1, d, 98376-9037d, d, d d, b bd, 903c6-983cd, 993d6-903dd, 903e6-903ed, 90376 -0037d, 90820-9083T, 99848-90853, 90858, 91206-91.

monitor set_io_access_width,RW,1,91226-9122d,91236-9123d,91246-9124d,91256-9125d,91266-9126d,91276-9127d,91286-9128d, 91296-9129d, 912a6-912ad, 912b6-912bd, 912c6-912cd, 912d6-912dd , 912e5-912ed, 91.
monitor set_io_access_width,RW,1,91386-913@d,91316-9131d,91326-9132d,91336-9133d,91346-9134d,91356-9135d,91366-9136d, 91376-9137d, 91386-9138d,91396-9139d,913a6-913ad,913b6-913bd, 913¢6-913cd, 91 -

< I b

7. Click Restart on the toolbar. The program will be executed and a break will occur at the start of the main function.

Debug - led_sample/r_bsp/board/rskrédm/resetprg.c - e2 studic
File Edit 5Source Refactor MNavigate 5egrch  Project Run  Window Help
TF9. | ®-Q - w ST B0 N[ Click here.
%5 Debug 23 Eb@'%@@”|ﬁ>
4 [ led_sample HardwareDebug [Renesas GDB Hardware Debugging]

4 Jf:‘ led_sample.x
a4 ' Thread [1]1 (No thread info available) (Suspended : Signal : SISTRAP:Trace/breakpoint trap]
= PowerOM_Reset PC() at resetprg.c:122 Oxffc017e8
v gdb
p| GDB server

[g] resetprg.c &2

8. After the break at the start of the main function, click Restart on the tool bar again.
The project will be run and the program will iterate toggling LEDO with a period of 0.5 seconds.
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435 For location of the API information of each FIT module
For the API information of FIT module embedded in the project, refer to the doc folder of each FIT module folder.
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5. RX Driver Package Application

5.1 RX Driver Package Application Structure

The RX Driver Package Application is a sample application program provided so that users can use the RX Driver
Package easily. The RX Driver Package Application consists of an application program that operates using device
drivers and middleware included in the RX Driver Package and a project file for building that application. This allows
users to start evaluation quickly.

RX Driver Package Application

| | p}'ogrl al - I l gro;ect !He I

Figure 5-1 RX Driver Package Application Structure

Renesas plans to release a variety of types of this RX Driver Package Application in the future, such as system
programs that operate using a combination of multiple drivers and middleware and evaluation programs for independent
modules from the RX Driver Package.

For information of the latest RX Driver Package Application, refer to the “Products Supporting RX Driver Package
Application” shown in the following URL.

http://www.renesas.com/products/mpumcu/rx/child/fit.jsp

Network server Camera Audio player
and client control program (ADPCM)
. . Image and video
Device driver i
d Boot loader middleware control
evaluation program
program
] RX Driver Package
RX Driver Package Application

Figure 5-2 Types of RX Driver Package Application
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6. Supplement

6.1 Commercial Version of Middleware and Drivers Supporting FIT
A list of the commercial version (paid) Middleware and Drivers for RX family is shown below.

For the information of the latest commercial version (paid) Middleware and Drivers, refer to the page of the
Middleware and Drivers shown in the following URL.

Page of Middleware and Drivers: http://www.renesas.com/mw/

Table 6-1 list of the commercial version (paid) Middleware and Drivers for RX family

Commercial Version URL FIT
Compliant

TCP/IP for Embedding http://www.renesas.com/mw/t4 Available

M3S-T4-Tiny
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Website and Support

Renesas Electronics Website
http://www.renesas.com/

Inquiries
http://www.renesas.com/contact/

All trademarks and registered trademarks are the property of their respective owners.
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General Precautions in the Handling of MPU/MCU Products

The following usage notes are applicable to all MPU/MCU products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that
have been issued for the products.

1.

Handling of Unused Pins

Handle unused pins in accord with the directions given under Handling of Unused Pins in the manual.

— The input pins of CMOS products are generally in the high-impedance state. In operation with an unused pin
in the open-circuit state, extra electromagnetic noise is induced in the vicinity of LSI, an associated shoot-
through current flows internally, and malfunctions occur due to the false recognition of the pin state as an
input signal become possible. Unused pins should be handled as described under Handling of Unused Pins in
the manual.

Processing at Power-on

The state of the product is undefined at the moment when power is supplied.

— The states of internal circuits in the LSI are indeterminate and the states of register settings and pins are
undefined at the moment when power is supplied.
In a finished product where the reset signal is applied to the external reset pin, the states of pins
are not guaranteed from the moment when power is supplied until the reset process is completed.
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset function
are not guaranteed from the moment when power is supplied until the power reaches the level at
which resetting has been specified.

Prohibition of Access to Reserved Addresses

Access to reserved addresses is prohibited.

— The reserved addresses are provided for the possible future expansion of functions. Do not access these
addresses; the correct operation of LSI is not guaranteed if they are accessed.

. Clock Signals

After applying a reset, only release the reset line after the operating clock signal has become stable.
When switching the clock signal during program execution, wait until the target clock signal has
stabilized.

— When the clock signal is generated with an external resonator (or from an external oscillator) during a reset,
ensure that the reset line is only released after full stabilization of the clock signal. Moreover, when
switching to a clock signal produced with an external resonator (or by an external oscillator) while program
execution is in progress, wait until the target clock signal is stable.

. Differences between Products

Before changing from one product to another, i.e. to a product with a different type number, confirm

that the change will not lead to problems.

— The characteristics of an MPU or MCU in the same group but having a different part number may differ in
terms of the internal memory capacity, layout pattern, and other factors, which can affect the ranges of
electrical characteristics, such as characteristic values, operating margins, immunity to noise, and amount of
radiated noise. When changing to a product with a different part number, implement a system-evaluation test
for the given product.




Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for

the incorporation of these circuits, software, and information in the design of your equipment. Renesas Electronics assumes no responsibility for any losses incurred by you or third parties arising from the use

of these circuits, software, or information.

2. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics does not warrant that such information is error free. Renesas Electronics

assumes no liability whatsoever for any damages incurred by you resulting from errors in or omissions from the information included herein.

3. Renesas Electronics does not assume any liability for infringement of patents, copyrights, or other intellectual property rights of third parties by or arising from the use of Renesas Electronics products or

technical information described in this document. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or

others.

4. You should not alter, modify, copy, or otherwise misappropriate any Renesas Electronics product, whether in whole or in part. Renesas Electronics assumes no responsibility for any losses incurred by you or

third parties arising from such alteration, modification, copy or otherwise misappropriation of Renesas Electronics product.

5. Renesas Electronics products are classified according to the following two quality grades: "Standard"” and "High Quality". The recommended applications for each Renesas Electronics product depends on

the product's quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic

equipment; and industrial robots etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-crime systems; and safety equipment etc.
Renesas Electronics products are neither intended nor authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems, surgical
implantations etc.), or may cause serious property damages (nuclear reactor control systems, military equipment etc.). You must check the quality grade of each Renesas Electronics product before using it
in a particular application. You may not use any Renesas Electronics product for any application for which it is not intended. Renesas Electronics shall not be in any way liable for any damages or losses
incurred by you or third parties arising from the use of any Renesas Electronics product for which the product is not intended by Renesas Electronics.

6. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, especially with respect to the maximum rating, operating supply voltage

range, movement power voltage range, heat radiation characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or damages arising out of the

use of Renesas Electronics products beyond such specified ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have specific characteristics such as the occurrence of failure at a certain rate and
malfunctions under certain use conditions. Further, Renesas Electronics products are not subject to radiation resistance design. Please be sure to implement safety measures to guard them against the
possibility of physical injury, and injury or damage caused by fire in the event of the failure of a Renesas Electronics product, such as safety design for hardware and software including but not limited to

redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult,

please evaluate the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. Please use Renesas Electronics

products in compliance with all applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive. Renesas Electronics assumes

no liability for damages or losses occurring as a result of your noncompliance with applicable laws and regulations.

9. Renesas Electronics products and technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws or
regulations. You should not use Renesas Electronics products or technology described in this document for any purpose relating to military applications or use by the military, including but not limited to the

development of weapons of mass destruction. When exporting the Renesas Electronics products or technology described in this document, you should comply with the applicable export control laws and

regulations and follow the procedures required by such laws and regulations.
10.

1)

contents and conditions set forth in this document, Renesas Electronics assumes no responsibility for any losses incurred by you or third parties as a result of unauthorized use of Renesas Electronics

products.

11. This document may not be reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products, or if you have any other inquiries.

(Note 1) "Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its majority-owned subsidiaries.

(Note 2) "Renesas Electronics product(s)" means any product developed or manufactured by or for Renesas Electronics.

It is the responsibility of the buyer or distributor of Renesas Electronics products, who distributes, disposes of, or otherwise places the product with a third party, to notify such third party in advance of the
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